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1 Introduction 
The present guide describes the upgrade from advanced editions of Acronis Backup & Recovery 10 
and Acronis Backup & Recovery 11 to advanced editions of Acronis Backup & Recovery 11.5. It also 
describes the upgrade from Acronis Recovery from Microsoft Exchange to Acronis Backup & 
Recovery 11.5 for Microsoft Exchange Server. 
 

2 Overview 

2.1 Upgrade from Acronis Backup & Recovery 10 
Out of Acronis Backup & Recovery 10 components, only agents can interact with components of 
Acronis Backup & Recovery 11.5. Hence, you first need to upgrade the management console, license 
server, management server, and storage nodes. Acronis Backup & Recovery 10 agents can continue 
backing up to the existing vaults.  

After that, upgrade some or all of the Acronis Backup & Recovery 10 agents. For example, you can 
upgrade agents on a single machine or on a few machines to test the new product, while the 
remaining machines are protected by Acronis Backup & Recovery 10. Then, upgrade the majority of 
the Acronis Backup & Recovery 10 agents and apply the proven technology to them.  

All agents that back up to tape devices attached to a storage node must be upgraded along with the 
storage node. 
 

2.1.1 Using old agents in the new environment 

General 

Be sure to use version of Acronis Backup & Recovery 10 agent not earlier than Update 2 (build 
11639).  

New console 

Acronis Backup & Recovery 11.5 console displays Acronis Backup & Recovery 11.5 Help even if 
connected to an Acronis Backup & Recovery 10 agent. It means that descriptions in the context help 
may differ from the appearance of the product windows and that the help may describe features 
which are not present in the product. 

New management server 

When creating a centralized backup plan, you cannot directly select data on a machine with an 
Acronis Backup & Recovery 10 agent. Use selection rules as you did when creating a backup policy in 
Acronis Backup & Recovery 10.  

When you run or stop a centralized backup plan manually, only Acronis Backup & Recovery 11.5 
agents carry out the action. Acronis Backup & Recovery 10 agents do not respond. 
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New storage node 

After upgrading the storage node, its managed vaults (except for those located on tapes) 
automatically become backward compatible. It means that both Acronis Backup & Recovery 10 
agents and Acronis Backup & Recovery 11.5 agents can back up to the vaults. 

Should you need to create a new managed vault and set up Acronis Backup & Recovery 10 agents to 
back up to it, enable the backward compatibility option when creating the vault.  

Remember that you cannot define Vault administrators and Vault users for backward compatible 
vaults. This functionality is exclusive for Acronis Backup & Recovery 11.5. You cannot convert a 
backward compatible vault to an ordinary managed vault either. 

Managed vaults located on tapes are not backward compatible. You need to upgrade all the agents 
that back up to such vaults. 

How different software versions work in a backward compatible managed vault 

 Acronis Backup & Recovery 10 agents and Acronis Backup & Recovery 11.5 agents write the data 
to such vaults in their respective formats. 

 Acronis Backup & Recovery 10 agents have access only to their backups while Acronis Backup & 
Recovery 11.5 agents can access any backup. 

 In a deduplicating vault, the backups written by Acronis Backup & Recovery 10 agents are not 
deduplicated with the backups written by Acronis Backup & Recovery 11.5 agents and vice versa. 
Each product has its own deduplication datastore. 

 

2.1.2 What happens with backup policies and plans 

After the upgrade, all backup plans, recovery tasks and validation tasks will be preserved. Backup 
policies will be converted to centralized backup plans. 

Centralized backup plans that reside on a management server provide all the functionality previously 
provided by backup policies. If you edit such a plan, the changes will be deployed to all machines 
included in the plan. To "apply" such a plan to a machine or a group or to "revoke" it, just edit the 
plan to add or remove the machine or the group. In addition to using selection rules, you can directly 
select data to back up on each machine. However, both methods of selection cannot be used within 
one backup plan. 
 

2.1.3 Backup to tapes 

Unlike Acronis Backup & Recovery 10, Acronis Backup & Recovery 11.5 does not use Windows 
Removable Storage Manager (RSM). During an upgrade from Acronis Backup & Recovery 10, Acronis 
Backup & Recovery 11.5 writes the necessary information from RSM to its own database in the new 
format. 

This means that Acronis Backup & Recovery 11.5 can back up to tapes even if the Windows version 
installed on the machine does not support RSM. 
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2.2 Upgrade from Acronis Backup & Recovery 11 

Using old agents in the new environment 

Out of Acronis Backup & Recovery 11 components, only agents can interact with components of 
Acronis Backup & Recovery 11.5. Hence, you first need to upgrade the management console, license 
server, management server, and storage nodes. Acronis Backup & Recovery 11 agents can continue 
backing up to the existing vaults.  

After that, upgrade some or all of the Acronis Backup & Recovery 11 agents. For example, you can 
upgrade agents on a single machine or on a few machines to test the new product, while the 
remaining machines are protected by Acronis Backup & Recovery 11. Then, upgrade the majority of 
the Acronis Backup & Recovery 11 agents and apply the proven technology to them. 

New console 

Acronis Backup & Recovery 11.5 console displays Acronis Backup & Recovery 11.5 Help even if 
connected to an Acronis Backup & Recovery 11 agent. It means that descriptions in the context help 
may differ from the appearance of the product windows and that the help may describe features 
which are not present in the product. 

New management server 

Acronis Backup & Recovery 11.5 management server works with Acronis Backup & Recovery 11 
agents without limitations. 

New storage node 

Acronis Backup & Recovery 11.5 storage node works with Acronis Backup & Recovery 11 agents 
without limitations. It means that after upgrading the storage node, both Acronis Backup & Recovery 
11 agents and Acronis Backup & Recovery 11.5 agents can back up to its managed vaults. 

What happens with backup plans and tasks 

After the upgrade, all centralized and local backup plans, recovery tasks, and validation tasks will be 
preserved. 
 

3 Before the upgrade 

Update or upgrade Acronis Backup & Recovery 10 if necessary 

If Acronis Backup & Recovery 10 version is earlier than Update 2 (build 11639) 

You need to update Acronis Backup & Recovery 10 to the latest version before upgrading it to 
Acronis Backup & Recovery 11.5. Otherwise, the setup program will remove Acronis Backup & 
Recovery 10 and will install Acronis Backup & Recovery 11.5 anew. Hence, you will lose all your logs, 
tasks, vaults and configuration settings.  

If Acronis Backup & Recovery 10 is installed on a Linux machine 

This relates to a Linux machine on which Acronis Backup & Recovery 10 Agent for Linux or 
Management Console is installed. 
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You can upgrade Acronis Backup & Recovery 10 components directly to Backup & Recovery 11.5. In 
this case, the setup program will remove Acronis Backup & Recovery 10 and will install Acronis 
Backup & Recovery 11.5 anew. Hence, you will lose your logs, tasks, personal vaults, and 
configuration settings that are stored on the machine. You will need to re-create tasks and vaults and 
to configure the software again. However, the backups will remain intact. 

If you want to keep your configuration, upgrade Acronis Backup & Recovery 10 to Acronis Backup & 
Recovery 11 before upgrading it to Acronis Backup & Recovery 11.5. In this case, you will need a pair 
of an upgrade license key for Acronis Backup & Recovery 11 and a full license key for Acronis Backup 
& Recovery 10 per machine on which you want to upgrade the agent. For more details about 
upgrading to Acronis Backup & Recovery 11, see the "Upgrading to advanced editions of Acronis 
Backup & Recovery 11" document. 

Obtain the license keys 

Prior to the upgrade, make sure that you have the appropriate number of license keys for Acronis 
Backup & Recovery 11.5. You can use the following license keys: 

 An upgrade license key for Acronis Backup & Recovery 11.5 + a license key for an old product. 

You need one pair per machine on which you want to upgrade the licensed component (agent). 

As the old key, you can use a full or upgrade key for Acronis True Image 9.1/Echo, Acronis Backup 
& Recovery 10, or Acronis Backup & Recovery 11, regardless of the product installed on the 
machine. 

 A full license key for Acronis Backup & Recovery 11.5. In this case, old license keys are not 
required. 

You need one license key per machine on which you want to upgrade the licensed component 
(agent).  

Back up a machine 

We recommend that you back up a machine before upgrading the software on it. This will allow you 
to roll back the machine to a previous state if the upgrade fails for any reason or if there are any 
issues after the upgrade. 

Choose the right time for the upgrade 

During the upgrade, Acronis services will be restarted and all Acronis tasks related to these services 
will be stopped. We recommend that you select the time for the upgrade when no backup plan or 
recovery task is running. 
 

4 Upgrade procedure 
The following procedure is the same when you upgrade from Acronis Backup & Recovery 10 and 
from Acronis Backup & Recovery 11. 
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4.1 Upgrading the license server, management server, 
console, and storage nodes 

Upgrading the software 

First, perform the following steps on the machine where the license server is installed. Then, repeat 
them on a machine (if any) where the management server, management console, or storage node is 
installed. 

1. Run the Acronis Backup & Recovery 11.5 setup program. 

2. Click Install Acronis Backup & Recovery 11.5. 

3. Accept the terms of the license agreement, and then click Next. 

4. Click Update or Modify. 

Details. Click Modify if you need to add or remove the product components. Select the check 
boxes next to the components you want to add, and clear the check boxes next to the 
components you want to remove. The components whose check boxes you leave selected will be 
upgraded. 

If you want to remotely upgrade agents on machines running Windows, add Components for 
Remote Installation when upgrading the management server. 

5. If Agent for Windows is installed on the same machine, you will be prompted to specify the 
license. Do the following: 

a. Make sure that the License server field contains the license server from which the agent 
license is taken. If not, click Specify or Change, specify the license server IP address or name, 
and then click OK to confirm. 

b. If the License for backup of disks/files list contains the Acronis Backup & Recovery 11.5 
edition that matches the edition installed on the machine, select it. 

Otherwise, click Add licenses and add the upgrade license keys to the license server. If the 
old license keys are not present on the license server, add them as well. 

6. Follow the on-screen instructions. 

7. On successful upgrade, click Finish to close the wizard window. 

8. If Acronis Startup Recovery Manager was activated on the machine, activate it again after the 
upgrade. 

If several Acronis Backup & Recovery 10 or 11 components are installed on the machine, all of them 
are upgraded. 

Adding license keys to the license server 

If you have added the upgrade license keys to the license server during the upgrade procedure, skip 
this step. Otherwise, add the license keys to the license server now. Do the following: 

1. Run the console by double-clicking the Acronis Backup & Recovery 11.5 icon on the desktop.  

2. On the Tools menu, click Manage licenses.  

3. Specify the IP address or name of the license server and click OK. If prompted for credentials, 
specify the user name and password. 

4. Either type the upgrade keys or import them from a file. If the old license keys are not present on 
the license server, add them as well. 

 



9 Copyright © Acronis International GmbH, 2002-2013 

 

 

4.2 Upgrading Agent for Windows and Agent for Linux 
You can upgrade the agents either locally or remotely. 

The remote upgrade is most effective when you have many machines with an identical set of Acronis 
Backup & Recovery 10 or 11 components installed.  

To learn which agents are installed on a machine, connect the console to the management server, 
click Machines with agents > All machines with agents, right-click the required machine, and then 
click View details. To view whether Deduplication and/or Universal Restore is installed on the 
machine, right-click the required machine, and then click Change license. 
 

4.2.1 Local upgrade of Agent for Windows 

On each machine with an agent, do the following: 

1. Run the Acronis Backup & Recovery 11.5 setup program. 

2. Click Install Acronis Backup & Recovery 11.5. 

3. Accept the terms of the license agreement, and then click Next. 

4. Click Update. 

5. Make sure that the License server field contains the license server from which the agent license 
is taken. If not, click Specify or Change, specify the license server IP address or name, and then 
click OK to confirm. 

6. In the License for backup of disks/files list, select the Acronis Backup & Recovery 11.5 edition 
that matches the edition installed on the machine. Click Next. 

7. Click Update to proceed with upgrade. 

8. If Acronis Startup Recovery Manager was activated on the machine, activate it again after the 
upgrade. 

 

4.2.2 Local upgrade of Agent for Linux 

Downloading installation files 

Before proceeding with the upgrade, you need to download the installation files and assign them 
necessary access permissions: 

1. Go to the Acronis Web site. 

2. Depending on the machine platform and your edition of Acronis Backup & Recovery 11.5, 
download the installation file or files (.i686 or .x86_64 files). 

3. Copy the installation files to a directory on the machine where you want to install Acronis Backup 
& Recovery 11.5. 

4. Go to the directory where you copied the installation files, and then run the following command: 

chmod 755 ABR11* 

Upgrade steps 

On each machine with an agent, do the following: 

1. Run the downloaded installation file as the root user.  

2. In the welcome window, select Next. 

3. Accept the terms of the license agreement. 
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4. Select Next, and then specify the license server. 

5. Follow the on-screen instructions. 

6. If Acronis Startup Recovery Manager was activated on the machine, activate it again after the 
upgrade. 

 

4.2.3 Remote upgrade 

4.2.3.1 Preparation 

Preparation of machines running Windows 

Before proceeding with remote upgrade, prepare the remote machines as follows: 

 Simple file sharing. For successful upgrade on a remote machine running any Windows XP 
version, the option Control panel > Folder options > View > Use simple file sharing must be 
disabled on that machine. 

 User Account Control. For successful upgrade on a remote machine running Windows Vista or 
later, User Account Control (UAC) must be set to Never notify. To access this option, go to 
Control panel > View by: Small icons > User Accounts > Change User Account Control Settings. 
This change requires a machine reboot. 

 File and Printer Sharing must be enabled on a remote machine. To access this option: 

 On a machine running Windows XP with Service Pack 2 or Windows 2003 Server: go to 
Control panel > Windows Firewall > Exceptions > File and Printer Sharing. 

 On a machine running Windows Vista, Windows Server 2008, or Windows 7: go to Control 
panel > Windows Firewall > Network and Sharing Center > Change advanced sharing 
settings. 

 Ports. Acronis Backup & Recovery 11.5 uses TCP ports 445 and 25001 for remote upgrade. Also, 
it uses TCP port 9876 for remote upgrade and for communication between the components.  

Port 445 is automatically opened when you enable File and Printer Sharing. Ports 9876 and 
25001 are automatically opened through Windows Firewall. If you use a different firewall, make 
sure that these three ports are open (added to exceptions) for both incoming and outgoing 
requests. 

After the remote upgrade is complete, you can remove ports 445 and 25001 from exceptions. 
Port 25001 is automatically closed through Windows Firewall. Port 9876 needs to remain open. 

Preparation of machines running Linux 

1. Make sure that TCP port 22 is opened and that the SSH daemon is running on each virtual 
machine you want to upgrade. After the remote upgrade is complete, you can close the port and 
stop the SSH daemon. 

2. Open TCP port 9876 on each virtual machine you want to upgrade. Acronis Backup & Recovery 
11.5 uses this port for communication between the components; therefore, it must remain open 
for both incoming and outgoing requests. 

3. By default, the management server takes the installation packages from the 
folder %CommonProgramFiles%\Acronis\RemoteInstaller\<product build number>. 
To be able to remotely upgrade Agent for Linux, download the agent installation files (.i686 
or .x86_64) from the Acronis Web site and put them into this folder on the management server. 
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4.2.3.2 Upgrade 
1. Connect the console to the management server where you have installed the Components for 

Remote Installation. 

2. On the Tools menu, click Install Acronis components. 

3. Select the machines on which the components are to be upgraded. Specify each machine's name 
or IP address and the administrator's user name and password. You can also add machines by 
browsing the network, by browsing an Active Directory domain, by importing the list of the 
machines from a .txt or .csv file, or from RHEV environment. Click Next to continue. 

4. In the list of components, select all components that are installed on the machines. Be sure to 
select the agents' add-ons (Deduplication, Universal Restore) if they are installed. You can also 
add other Acronis Backup & Recovery 11.5 components or add-ons to install. 

5. Specify the license server and provide access credentials for it. 

6. Follow the on-screen instructions. 

7. If Acronis Startup Recovery Manager was activated on the machines, activate it again after the 
upgrade. 

 

4.3 Upgrading Agent for ESX(i) 

Licenses 

Make sure that you have licenses described in "Before the upgrade" (p. 6). You need licenses for all 
ESX(i) hosts you want to upgrade. Add these licenses to the license server before starting the 
upgrade. 

Note for upgrade from Acronis Backup & Recovery 10. 
After you upgrade a part of the existing agents, the new management server automatically distributes virtual 
machines among them. Since the old agents do not provide the information necessary for automatic 
distribution, they do not participate in it. As a result, all of the load will be concentrated on the new agents. 

Agent for ESX(i) (Virtual Appliance) 

You can upgrade only those agents that are registered on the management server. If some of the 
agents are not registered, register them before upgrading. 

To upgrade the agents from the management server 

1. Connect the console to the management server. 

2. In the Navigation tree, right-click the group that has the same name as the vCenter Server. If 
VMware vCenter integration is not enabled, right-click Virtual machines.  

3. Click Update Agent for ESX(i).  

4. Select the agents that you want to upgrade. Agents that are already of the latest version are 
unavailable for selection. 

5. Click Update Agent for ESX(i). 

The agents will be upgraded; their configuration settings will be preserved. 

Agent for ESX(i) (Windows) 

Follow the upgrade procedure for Agent for Windows (p. 9). The only difference is that you do not 
need to specify license keys during upgrade. 
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4.4 Upgrading Agent for Hyper-V 
Agent for Hyper-V enables you to back up and recover virtual machines from a Hyper-V host without 
installing agents on the virtual machines. To upgrade Agent for Hyper-V, you need one upgrade 
license per Hyper-V host. 

 In Windows 2008/2008 R2, Agent for Hyper-V is upgraded along with Agent for Windows (p. 9). 

 In Microsoft Hyper-V Server 2008/2008 R2, you can upgrade the agent remotely (p. 10). 

Acronis Backup & Recovery 11.5 features Hyper-V cluster support. If you have a Hyper-V cluster (also 
called a failover cluster), we recommend that you install Agent for Hyper-V on each node of the 
cluster. This will enable you to back up a clustered virtual machine no matter what node it migrates 
to. 
 

4.5 Upgrading the command-line utility 
Acronis Backup & Recovery 11.5 supports the command-line interface with the acrocmd utility. 

Upgrade from Acronis Backup & Recovery 10 

Unlike the trueimagecmd utility used in Acronis Backup & Recovery 10 or earlier, acrocmd does 
not contain any tools that physically execute the commands. It merely provides the command-line 
interface to Acronis Backup & Recovery 11.5 components—agents, storage nodes and the 
management server. As with Management Console, you install the command-line utility on the 
machine from which you prefer to operate (run commands or scripts).  

If you are not going to use old scripts, it is enough to install the utility on one machine (for example, 
where the console is installed). Other machines will be operated remotely. 

How to continue using old scripts 

To continue using your existing scripts, edit them so that trueimagecmd is replaced with acrocmd. 
If your scripts contain the path to the trueimagecmd utility, replace it with the path to the acrocmd 
utility. Retain all other parameters and values. 

Installation procedure 

The software installs the command-line utility on every machine where an agent is installed. No 
additional actions are needed. 

Upgrade from Acronis Backup & Recovery 11 

The acrocmd utility usually installs along with other Acronis Backup & Recovery 11 components. If 
you have upgraded these components, your command-line utility has also probably been upgraded. 
If there is a machine where only the utility is installed, run the setup program on this machine and 
upgrade the command-line utility in the same way as other components. 
 

4.6 Upgrading bootable media 
As a part of the upgrade process, you should create an Acronis Backup & Recovery 11.5 bootable 
media. 

Bootable Media Builder usually installs along with an agent or a console. If you have upgraded the 
agents and the console, your media builder has also probably been upgraded. If there is a machine 
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where only the media builder is installed, run the setup program on this machine and upgrade the 
media builder in the same way as other components. Then, create bootable media using the 
upgraded media builder. 
 

5 Tips for further usage 

5.1 After upgrading from Acronis Backup & Recovery 10 

5.1.1 Catalog old backups 

Acronis Backup & Recovery 11.5 has a feature called data catalog. It allows you to easily find the 
required version of data and select it for recovery. Backups created by Acronis Backup & Recovery 
11.5 are cataloged automatically.  

You can include the backups created by Acronis Backup & Recovery 10 in the catalog. To do this, 
connect the console to the management server or to a new agent, go to the vault where the backups 
are located, click the Data view tab and click the start cataloging now or update the catalog now link. 
Please be aware that the cataloging procedure may be time- and resource-consuming. 
 

5.1.2 Retire backward compatible managed vaults 

After you have upgraded all the Acronis Backup & Recovery 10 agents, backward compatible 
managed vaults are no longer needed. You have two options to choose from: 

 Leave a backward compatible vault "as is" and continue backing up to it  

You will not be able to define Vault administrators and Vault users for the vault. Besides, if the 
vault is a deduplicating one, the old archives will not be deduplicated with the archives written 
by Acronis Backup & Recovery 11.5 agents. This decreases the deduplication ratio. 

 Create a new vault without the backward compatibility property 

You will have to edit the backup plans to redirect the backups to the new vault. The backups in 
the old vault remain available as long as you need them. Once their retention period expires, 
delete the backups and the vault. 

If you want to move the old archives to the new vault, export them using the following 
command: 

acrocmd export archive --service=asn --host=<storage node> --credentials=<storage 
node user name>,<password> --loc=<old vault> --target=<new vault> 
--credentials=<new vault user name>,<password> --target_arc=<new archive name> 

Since the export is performed by Acronis Backup & Recovery 11.5, the old archives will be 
treated as if they were created by Acronis Backup & Recovery 11.5. If the target vault is a 
deduplicating one, the old archives will be deduplicated with the archives written by Acronis 
Backup & Recovery 11.5 agents. 

After the export is completed, you need to catalog the new vault. 
 

5.1.3 Use 64-bit Storage Node 

Acronis Backup & Recovery 11.5 Storage Node has a 64-bit version. It provides better deduplication 
performance and can process more unique data. In a 64-bit system, the 64-bit version is installed 
automatically during the upgrade. No additional action is required. 
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If you are using deduplication on a 32-bit storage node, we highly recommend that you migrate to a 
64-bit system. A 32-bit system can effectively process not more than 400 GB of unique data. Even if 
you are satisfied with the current deduplication performance, the appropriate hardware will provide 
a reserve in case you will need to back up more machines in the future.  

For more information about requirements for the storage node, see the "Deduplication best 
practices" section of the product Help or User Guide. 
 

5.2 After upgrading from Acronis Backup & Recovery 10 
or 11 

5.2.1 Use the management server Web page for installation 

The management server Web page, available in Acronis Backup & Recovery 11.5, can be used for 
installation on multiple machines in a network that does not allow sharing folders. You can go to that 
Web page from any machine with a supported Web browser. 

To start using the Web page, make sure that the Components for Remote Installation component is 
installed on the machine with the management server. If not, install these components. To activate 
the service, run the Services snap-in, change the logon parameters of Acronis Web Server Service to 
the account of any user belonging to the Acronis Centralized Admins group, and then start the 
service. 
 

6 What else you may want to know 
Will the default backup and recovery options be preserved after the upgrade? 

Yes, with a few exceptions.  

 Options of Acronis Backup & Recovery 10 that are not present in Acronis Backup & Recovery 
11.5: 

 The Overwrite data on a tape without prompting for user confirmation and Dismount 
media after backup has finished backup options. 

 The Save software RAID and LVM metadata along with backups option. The metadata is 
always saved in Acronis Backup & Recovery 11.5 backups. 

 Options of Acronis Backup & Recovery 11  that are not present in Acronis Backup & Recovery 
11.5: 

 The Use FTP in Active mode backup and recovery option. To establish an active mode FTP 
connection, specify aftp://ftp_server:port _number when selecting the backup location. 

 The After recovery, run the preconfigured Acronis Recovery for MS Exchange bare-metal 
recovery task (if available) recovery option. 

 The Eject tape - When the tape is full backup option of Acronis Backup & Recovery 11 
version earlier than Update 0.5 (build 17437). 

 The Automatically catalog backup as soon as it is created backup option of Acronis Backup 
& Recovery 11 version earlier than Update 0.5 (build 17437). Instead, you can select whether 
to perform full or fast cataloging. 

Is it possible to upgrade to a different language version of the product? 
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If the language version of Acronis Backup & Recovery 10 or 11 does not match the language version 
of Acronis Backup & Recovery 11.5, you have to uninstall the old product and then install Acronis 
Backup & Recovery 11.5 anew. In this case, you can use the same license keys as described in "Before 
the upgrade" (p. 6). 

Is it possible to upgrade from Acronis True Image Echo? 

If you want to upgrade from Acronis True Image Echo to Acronis Backup & Recovery 11.5 and retain 
your tasks and settings, you need to upgrade to Acronis Backup & Recovery 10 first. For more details, 
see the "Upgrading to advanced editions of Acronis Backup & Recovery 10" document. 
 

7 Upgrade from Acronis Recovery for Microsoft 
Exchange 

Upgrading from Acronis Recovery for Microsoft Exchange to Acronis Backup & Recovery 11.5 means 
that you install Acronis Backup & Recovery 11.5 Agent for Microsoft Exchange Server (hereinafter 
referred to as Agent for Exchange) on a machine with Acronis Recovery for Microsoft Exchange. 

As a result: 

 Acronis Recovery for Microsoft Exchange is automatically uninstalled and Acronis Backup & 
Recovery 11.5 is installed. 

 Tasks of Acronis Recovery for Microsoft Exchange are deleted. 

 Backups created with Acronis Recovery for Microsoft Exchange remain intact and you can 
recover from them. For more information about the operations that Acronis Backup & Recovery 
11.5 can perform with old archives and backups, see the "Supported operations with legacy 
archives and backups" section of the "Backing Up Microsoft Exchange Server Data" document. 

Limitations 

Acronis Backup & Recovery 11.5 does not support Microsoft Exchange 2000 Server and Windows 
2000. So, you cannot perform the upgrade on this Exchange or Windows version. 

License keys 

When installing Agent for Exchange, you can specify the following pairs of license keys: 

 Upgrade license key for Acronis Backup & Recovery 11.5 for Microsoft Exchange Server + 
full license key for Acronis Recovery for Microsoft Exchange. 

 Upgrade license key for Acronis Backup & Recovery 11.5 Advanced Server SBS Edition + 
full license key for Acronis Recovery for Microsoft Exchange SBS. 

 Upgrade license key for Acronis Backup & Recovery 11.5 Advanced Server SBS Edition + 
full or upgrade license key for Acronis Backup & Recovery 10 or 11 Advanced Server SBS Edition. 

Installation with full license keys for Acronis Backup & Recovery 11.5 for Microsoft Exchange Server is 
also possible. In this case, old license keys are not required. 

Installation procedure 

If no other Acronis product is installed on the same machine 

Install Agent for Exchange as described in the Installation Help available in the Acronis Backup & 
Recovery 11.5 setup program. 
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If Acronis Backup & Recovery 10 or 11 is installed on the same machine 

1. Run the Acronis Backup & Recovery 11.5 setup program. 

2. Click Install Acronis Backup & Recovery 11.5. 

3. Accept the terms of the license agreement, and then click Next. 

4. Click Modify, and then select Agent for Microsoft Exchange in the tree. Click Next. 

5. You will be notified that Acronis Recovery for Microsoft Exchange components will be uninstalled. 
Click Next. 

6. Select the licenses: 

a. Make sure that the current license server is specified in the License server field. If not, click 
Specify or Change, specify the license server IP address or name, and then click OK to 
confirm. 

b. Specify the license for backing up disks and files (if Agent for Windows is installed):  

If the License for backup of disks/files list contains the necessary Acronis Backup & Recovery 
11.5 edition, select it. 

Otherwise, click Add licenses and add the upgrade license keys to the license server. If the 
old license keys are not present on the license server, add them as well. 

c. Specify the license for backing up Microsoft Exchange Server data: 

Click Add licenses and add the upgrade license keys to the license server. If the old license 
keys are not present on the license server, add them as well. 

7. Follow the on-screen instructions. 

8. On successful upgrade, click Finish to close the wizard window. 
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